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Communicate: In Print 
A simple guide  

Work areas 
Communicate: In Print has two different modes in which to edit your documents: Create and 
Adjust modes. These are easily interchangeable and the toolbars will change with the 
modes.  

- green background (scratch area)

- blue background (scratch area)

1st Floor, Bishops House, Artemis Drive, 
Tachbrook Park, Warwick, CV34 6UD, UK 

t: 01926 333680    info@widgit.com 
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Free frames (grow as you type!) If you create a free frame 
but do not type anything 
into it and click away from 
it, that frame will 
disappear. 

Free text with symbols. 

Free text – no symbols. 

To create a frame:  

Left click on the appropriate button 
Left mouse drag the frame to the position and size required on the page 

OR  

Left click once on the button and once on the page - a default size frame will be created. 

The frame will grow as you type. 

Changing Symbols linked to a word 

Left click free text with symbols and create a frame. As you type into the frame a 
symbol will appear each time you press the space bar. 

The Symbols Choice box on the 
right of the work area shows all 
the graphic options for that word 
enabling you to choose the most 
appropriate for your needs.  

Click on any word on the page to 
see the alternative symbols 
available in the Symbols 
Choice box on the right. 

Remove symbols for any word by 
clicking in the word and immediately 
clicking the Hide symbol button. 
In this way you can manage the level 
of support to be given e.g. only nouns 
or verbs are supported by symbols 

Change the symbol by clicking 
on the graphic in the box OR 
toggle through symbols using the 
F9 key. 
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Changing the appearance of fonts and symbols 

 
 
 

You can alter the size and colour of the text and the 
size of the symbol by using the options in the Font 
box on the right of the Create screen. 

You can change the width and shape of a 
free frame by right clicking on the frame 

and adjusting by dragging either the corner 
or side blue squares– click outside the 

frame to set the shape. 
N.B. you cannot change the length of a 

free frame – it grows as you type. 

Switch between colour and black Choose from a s
skin tones by tog
tone button. 

election of 5
gling the skinand white symbo

the colour mode s
ls by toggling
ymbol. 

Changing the word linked to a symbol 

Clicking the change the text button (cat/sam) or pressing the F11 key on your keyboard 
allows you to change the labelling of a symbol.  

Put the curser on the centre of the word you wish to change and click cat/sam or press F11, 
the word will be removed and you can then type in the required word  

Click the right arrow key on 
the keyboard to tell the 
program you have completed 
the changes. You can rename 
a symbol with up to 5 words.  
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Adding your own images to words 

You can add your own images to a word and save them so they can be used again. 

Defaults to Widgit 
Pictures but you can 
navigate to other folders 
on your system by using 
the dropdown menu and 
browsing folders for 
graphics files! 

 
 
 
 
 

Click on the graphics 
button on the left 
toolbar. 
The Graphics panel will 
appear on the right. 

Click on Pictures A will take 
you to your My pictures 
folder so you can add digital 
photographs or images 
saved from the internet. 

When you have chosen your 
image/photograph from the 
thumbnail selection shown in the 
Graphics panel then left click on 
the image and left click on the word 
and the image will appear above the 
word. 

It will also been shown as an alternative in the  
Symbol Choice box 

To add the chosen image/photograph/word 
as a permanent alternative in your wordlist 
click on Wordlists on the top toolbar and 
choose Save Wordlist Changes. 
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Fixed Frames (remain static as you type!) d Frames (remain static as you type!) 

Fixed frame with symbols 

You create frames in the same way as free frames: You create frames in the same way as free frames: 

Left click on the appropriate button. Left click on the appropriate button. 
Left mouse drag the frame to the position and size required on the page Left mouse drag the frame to the position and size required on the page 

OR  OR  

Left click once on the button and once on the page - a default size frame will be created. Left click once on the button and once on the page - a default size frame will be created. 

Fixed frame - no symbols 

Fixed frames have a thick red 
border as default. 

The size of the frame does not 
change as you type. 

Changing the size/ moving frames Changing the size/ moving frames 

To change the size of a frame right click on 
the frame  
Blue squares will appear around the edge 
Left click and drag the points to the size 
you want 
Click outside the frame to set the size. 
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Changing the appearance of frames 

Highlight the frame by right clicking in it (blue handles appear)  
Then click on the Frames and Pictures menu on the top toolbar and choose Appearance. 

You can change the border 
colour or make it transparent 

You can change the background 
colour or make it transparent 

You can change the line colour 
or make it transparent 

You can change the border 
radius from 1 (square) to a 

rounded corner 

You can change the line 
thickness 

You can change the border 
width 

You can change the internal 
writing space, from 1 (the 

minimum) upwards to have 
more free space around your 

text 

Fitting contents into fixed frames 

If you find that the objects within your fixed frame do not fit to your liking you can 
maximise them by clicking the Fit to Frame button.  

The contents will grow to the maximum size possible in your frame 

If a completed frame is too small -
enlarge the frame first and then 
click the Fit to frame button to 

adjust the contents to fit. 

e.g.
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If you only want an image in a frame click on the Graphics button and choose Use list. 

hoose Symbol List to search for a symbol 
hoose Picture List to choose from the Widgit Pictures (clipart)  

 
 the frame 

it the 
ame.  

opying and moving frames on the page 

copy (blue squares will appear). 

C
C

Type the word you want and click “Find” 

Click on the required image and then click
in

The picture / symbol will be sized to f
fr

C

To copy a frame right click in the frame you want to 

or Ctrl X - Cut copies the highlighted object to your clipboard 
and then deletes it.  

or Ctrl C - Copy just copies the highlighted object to your 
clipboard. 

or Ctrl V - Paste retrieves the contents of the clipboard.  

You can then move the frame to wherever you wish on the page by using the left mouse 
utton to drag it into position.  

und the frame for you to move it – if they are not there 
ght click on the frame again. 

or Ctrl D - Duplicate copies and pastes the object. 

Duplicate does 
not copy the 

c  
makes an exact 

object to the 
lipboard it only

copy of the 
object on the

b

NB: Blue squares must be aro
ri

By moving the frames around the page and altering 
their size and appearance you can create any style of 
worksheet you can imagine! 

You can nudge the frames 
into position by using the 

d arrow keys on your keyboar
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A

Straight lines 
Free lines

Colour 
choice

dding lines 

 lines to your page open the Graphics panel  
 tab. 

hoose the:   
rrow style 

ne thickness 

nt the line to start  
u want it to end.

h end.  

You can now alter the size and direction of the line  
by left clicking and dragging 
or change the appearance of the line by clicking on the  

If you want to add
Choose the Lines

C
a

li

line style 

eft click where you wa
hen left click where yo

L
T

The line will appear with blue squares at eac

options in the lines box. 
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Making Tables 

make a table, first you make a frame the size you want the table cells to 
 not the size of the whole table.  

It is a good idea to set this frame to have the properties you want for the 

d 

ou can choose make a table of either: 

ixed cell size – This will use the number of frames to 

tton you require, then fill in the 

you have chosen the first option, fill in the 

he table later, either by dragging, or by going to 
z

ellow drag points allow you to resize the table. The cells will 

o get them back if they disappear right click on the table

To 
be,

whole table, for example you might want to centre the text. 

Click on Frames and Pictures on the top toolbar an
choose Make a Table. 

Y
Fixed table size – This will use the values in mm to 
set the table size 
F
set the table size 

Select the radio bu
number of cells you wish to have.  

If 
dimensions for the table.  

NB: You can change the size of t
Frames and Pictures>Edit table si e. 

This will give you a set of grouped frames for you to transform. 

Y
resize to fit the external space. 

T
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Altering the appearance of tables 

ou can insert a row either above or below the 
w with the current cell (the one with the cursor 

o to the Frames and Pictures menu select

t which option you require and the row or 
olumn will be inserted. 

 the cursor, 
imply select Delete.  

ot have a constant width  

erging Cells  

elect the cells you want to merge. Use CTRL 

ill be marked by dotted lines around 
em 

he Frames and Pictures menu select Merge table cells

his will merge the cells as shown: 

Y
ro
in).  

G
Rows or Columns to see the options. 

Selec
c

To delete a row containing the cell with
s

If the cells in the row do n

M

S +SHIFT + Left click to multiply select items.

The selected cells w
th

From t . 

T
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Copying to the Windows clipboard 

You can also copy a frame and its contents to the Windows clipboard using  
CTRL + ALT + C. This copies it as a single bitmap graphic, which you can then paste into 
other applications. You can copy any object - a writing frame, a graphic or a group of 
objects. 

Building a scene 

ou may wish to put a series of objects to make a 
r to create a story frame/book 

 be layered.  

lick on the graphic you wish to adjust whilst in Adjust mode.  

wn below) to position it at either the front or the 
ack, or to move it forward or backwards one level. 

Y
worksheet o

The Widgit Pictures are designed so they can

 
 
In Create mode choose the images you want 
to layer from the Graphics panel. 

C

Click one of the corresponding buttons (sho
b

 bring to the front (CTRL + R) 

 bring forward (CTRL + E) 

 send backwards (CTRL + W) 

 send to the back (CTRL + Q) 

Return to Create mode to add text to your sheet. 
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You can group objects in adjust mode so you can re-size and move as a single entity. 

Speech bubbles 

          Click on this button to bring in your speech bubble options. 

peech bubbles can be used with graphics or photographs. 
hey are not symbolised, but you can symbolise specific words by using the 
raphics options panel. 

 Adjust
roups.  

elect your item and then click on th

he corner drag points change from square to r  points to th
esired position and release.  

The same method can be used to build scenes to illustrate stories / books. 

S
T
g

Rotating images 

In  mode you can rotate individual graphic or text frames, but you cannot rotat

e rotate button.  

ound. Drag one of these

e 

e 

g

S

T
d
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ou can also rotate byY  setting the rotation angle from the Frames and Pictures menu. 

B If you want to edit a rotated frame double click on it and it will return to normal. 

age Tr

ou can d  
ou change the justing the blue drag 

ct when you change its size, hold down the 

B: If you 
spect ratio do

You cannot edit the colour of a 
rotated graphic, or edit the text in 
a rotated frame. So it is best to 

make all the changes you want 
before you rotate it.

N
Make any changes and then re-rotate it.  

Im ansforming 

rag an image through itself to flip it.
size of graphics by ad

Y
Y points. 

If you want to keep the aspect ratio of the obje
Shift key whilst dragging a corner tab. 

N want an image to return to its original  
uble left click on it.  

Aspect ratio? 
will remain circular 

ort when you 
change it’s size!! 

e.g. a circle 
and not dista
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Changing the colour of images / symbols 

he Widgit Symbols and Widgit Pictures are .emf files and have a set palette per image.  

ou can edit this palette to change the colour of the images. This gives much more freedom 
to illustrate your stories.  

To edit a Widgit Picture or symbol click on the image and then click on the palette 
button. 

his will bring up the palette for that image.  

n the image in your document 

n
r click on one of the colours already there, or choose 

 

hen you have changed several colours, click 
k to now permanently set these changes, or 
lick cancel to go back to the original. 

T

Y

T

If you click o
you will see different colours in the palette 
highlighted.  

To cha ge a colour, click on the colour in the palette. This will bring up a new 
window of colours. Eithe
define custom colours. When you click ok you
panel.  

will go back to the palette 

W
o
c

When you change a colour in the 

 on. In other words 
you are actually changing the 

palette, you are NOT doing a fill. 

palette, you are changing all 
instances of that colour in the 

picture, not just the area you may 
have clicked
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Master Items 

aster items are objects that will ap
f your document.   

es and Pictures 
Master Page Items 

When you add pages to your book the master item will be added to the new pages. 
A master item will have red drag points, unless the object is locked in which case they will 
be grey.  

You cannot copy or duplicate a master item. 

M pear on every page 
o

Making Master Items 

Create you .  

Right click t and from the Fram
menu, sele  item to open the 
dialogue b

r object that you want to be a master item

 to get blue drag points around your objec
ct Master items then choose Make Master
ox:   

When you modify a master item then the 
changes are reproduced o
You can use master item
headers and footers, pag
Master items can be imag

n each page. 
s to make 
e numbering etc. 
es, frames or 

groups of objects. 

You can choose if the position is locked, and if the 
content is locked. 

You can choose the item will appear on all pages or 
just the left or right hand pages. 

You can set whether the item will appear from 
the beginning of the book, or start from your 
current page.  

If you have locked the 
position/ size of your master 
frame and want to change it 

you will need to go into 
Frames and Pictures and 
then Locking and Unlock 

position. 



Created by S. Smith & N. Palmer 
Birmingham Pupil and School Support, Vauxhall Gardens, Barrack Street B7 4HA 

P16 

© Widgit Software 2009 www.widgit.com 

Unmaking master items   

If you want to make a master item into a normal item, highlight it, click on the Frames and 
Pictures menu, select Master items 

This will leave the item on each page, but they will no longe

Guides 

Gui of 
you

They can be locked in position and can also be made into 
lines on 

This can help maintain page layout consistency. 

o position the guide line click and hold down your left mou
r vertical guide lines that border your document.

nt on the page. Notice 

e

d  on all pages.  

e.  

Drag the lines into position and then right click on the line to 

then choose Unmake Master 

r be linked. 

de lines are included to aid you in the positioning 
r layout.  

Book guides so that you can have the same guide
every page throughout your book.  

T se b l utton on either the horizonta
o

Now drag it to the position you wa
that the line turns green. 

To remove a guide 
drag it back off the 

page. 

Locked and Book Guides 

Gr

Re

Gre

en lines are page guides: they appear on that page only.  

lines are book guides: they appear 

y line are locked guides: they are locked into plac

choose to turn them into a Page, Book or Locked/Unlocked 
guide.  
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Rulers 

jects accurately. They are 
ing guides. The ruler units are in centimetres (cm).  

 on and off click on the View menu and 
lers.  

If you are working in a writing frame, the horizontal ruler will 
start at the beginning of the text.  

This is so you can edit the tabs spacing. 

up and move them about by double 
clicking on them. A blue area will appear on the top of the 

To put the rulers back in plac

Printing 

 most important fea  

rom the File menu, select Print Print dialogue: 

Printing as a book
document in a format that is ready 

scale the pages down so that two pages will fit 
to one side of paper. It will also c
pages to put together so that it a
in the right order when it is printed 

 Print as sheets will sc
to fit the paper size. Set as single 
sided, each page will b
separate sheet. Set as ouble sided, 

it will print odd numbered pages
you to turn the stack to print the 
numbered pages on the back. 

There are rulers you can use to help you position your ob
specially helpful when use

To turn the rulers
click on Show ru

You can pick the rulers 

ruler, which you can use to drag it about.  

e double click on them again. 

One of the
work. 

tures of In Print is the flexibility of ways that you can print your

F  to open the 

 prints your 

to fold into a booklet, with two 
document pages per side. It will 

alculate which 
ll fits together 

ale the pages 

e full size on a 
d

 and then ask 
even 

Portrait 
documents 

will 
 to 

fold to the 
left. 

Landscape documents 
the book will print so the 

fold is at the top. 
the book 
be ready
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Printing single sided and double sided 

If you choose double sided, it will print all of the ‘top’ sides and
tack of paper over and replace in the tray ready to print on the backs.  

 then ask you to turn the 

d so you will need to experiment with your printer to 
etermin e the pile of sheets when you put them 

back in the paper tray to print on the second side. This will be different when the 
paper is landscape from the way it goes in when printing in portrait sheets 

ocument to fit the paper size selected in the Print set-up. 
 you have A4 paper and choose Print as a book, then the resulting book will be A5. 

 aper and , then the resulting book will be A4.  
 3 printer respondingly larger. 

s

B: Each printer is different anN
d e which way round you have to plac

Paper size 

 Print will scale your dIn
If

If you have A4 p
you have an A

 choose to print as sheets
then the books will be corIf

Check out the online manual included in 
Communicate in Print 2 software for additional 

information. Go to the Help menu and then 
Manual. 
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